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Question Number : 1 Question Id : 2549896416 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

What is the meaning of 'Hibernate' in Windows?

Options :

1.  Restart the computer in Safe Mode

2.  Restart the computer in Hibernate Mode

3.  Shut down the computer terminating all the running applications

4.  A power-off mode that preserves the last state of the computer

   

Question Number : 1 Question Id : 2549896416 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Windows में हाइबरनेट से क्या तात्पयर् है?

Options :

1.  कंप्यूटर को सेफ मोड में िरस्टाटर् करना

2.  कंप्यूटर को हाइबरनेट मोड में िरस्टाटर् करना



3.  वतर्मान में चालू सभी एप्लीकेशनों को बंद करके कंप्यूटर को शट-डाउन करना

4.  वह पॉवर ऑफ़ मोड िजसमें कंप्यटूर पर सबसे अंत में िकया गया काम सुरिक्षत रहता है

   

Question Number : 2 Question Id : 2549896908 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In MS-Excel, ________ contain(s) one or more worksheets.

Options :

1.  the rows and columns

2.  the workbook

3.  the active cell

4.  the label

   

Question Number : 2 Question Id : 2549896908 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-Excel के ________ में एक या अिधक वकर् शीट्स होती हैं।

Options :

1.  रो और कॉलम

2.  वकर् बुक

3.  एिक्टव सेल

4.  लेबल

   

Question Number : 3 Question Id : 2549897257 Question Type : MCQ Option Shuffling : Yes 



Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following directories is used as a temporary mount 

point for mounting storage devices, such as CD-ROMs, floppy disks and USB (universal serial bus) 

key drives, in Linux?

Options :

1.  /mnt

2.  /kernel

3.  /usr

4.  /dev

   

Question Number : 3 Question Id : 2549897257 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िलनक्स में सीडी-रोम, फ़्लॉपी िडस्क और यूएसबी (यूिनवसर्ल सीिरयल बस) की ड्राइव जैसे माउंिटगं स्टोरेज िडवाइस के िलए िनम्न में से 

कौन सी डायरेक्टरी अस्थायी माउंट पॉइंट के रूप में उपयोग की जाती है?

Options :

1.  /mnt

2.  /kernel

3.  /usr

4.  /dev

   

Question Number : 4 Question Id : 2549897686 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0



The speed of a dot matrix printer is measured in ______ per second.

Options :

1.  characters

2.  letters

3.  symbols

4.  words

   

Question Number : 4 Question Id : 2549897686 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

डॉट मिैट्रक्स िप्रंटर की गित ______प्रित सेकंड में मापी जाती है।

Options :

1.  वणार्क्षर

2.  अक्षर

3.  प्रतीक

4.  शब्द

   

Question Number : 5 Question Id : 2549898457 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following returns the values along a linear trend in MS-Excel?

Options :

1.  LINEST function

2.  TREND function



3.  LN function

4.  LINT function

   

Question Number : 5 Question Id : 2549898457 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-Excel में, कौन सा फंक्शन िकसी रेखीय प्रवृित्त के मापदंड देता है?

Options :

1.  LINEST फंक्शन

2.  TREND फंक्शन

3.  LN फंक्शन

4.  LINT फंक्शन

   

Question Number : 6 Question Id : 2549898871 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is a specific instruction given to a computer application to perform some 

kind of task or function?

Options :

1.  Program

2.  Record

3.  Field

4.  Component

   



Question Number : 6 Question Id : 2549898871 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िकसी भी प्रकार का कोई काम संपन्न करने के िलए कंप्यटूर प्रोग्राम को िदया गया एक िविशष्ट िनदेर्श क्या कहलाता है?

Options :

1.  प्रोग्राम

2.  िरकॉडर्

3.  फील्ड

4.  कॉम्पोनेन्ट

   

Question Number : 7 Question Id : 2549899323 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is NOT a pointing device for providing input to the computer.

Options :

1.  Track ball

2.  Scanner

3.  Mouse

4.  Joystick

   

Question Number : 7 Question Id : 2549899323 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्निलिखत में से कौन सा कंप्यटूर को इनपुट प्रदान करने के िलए एक पॉइंिटगं िडवाइस नहीं है?



Options :

1.  टै्रक बॉल 

2.  स्कैनर

3.  माउस

4.  जॉयिस्टक

   

Question Number : 8 Question Id : 2549899413 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The motherboard is:

Options :

1.  the circuit board that houses peripheral devices

2.  same as the CPU chip

3.  memory chip

4.  the circuit board that contains a CPU and other chips

   

Question Number : 8 Question Id : 2549899413 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

मदरबोडर् क्या होता है?

Options :

1.  एक सिकंट बोडर् िजस पर पेिरफेरल िडवाइस लगे होते हैं

2.  CPU िचप के समान

3.  मेमोरी िचप



4.  वह सिकंट बोडर् िजसमें CPU और अन्य िचप्स शािमल होते हैं

   

Question Number : 9 Question Id : 25498930067 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

______ can add more complexity to the standard process of biometrics by the combining of more 

than one biometric modality; for example, combining a fingerprint with an iris scan.

Options :

1.  Multimodal biometric system

2.  Privacy and discrimination

3.  Access control

4.  Cancelable biometrics

   

Question Number : 9 Question Id : 25498930067 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

बायोमेिट्रक्स की मानक प्रिक्रया को एक से अिधक बायोमेिट्रक िविधयों जैसे िक िफंगरिप्रटं के साथ आँख की पुतली के स्कैन के संयोजन 

से और अिधक जिटल बनाने की प्रिक्रया क्या कहलाती है? 

Options :

1.  मल्टीमॉडल बायोमेिट्रक्स िसस्टम

2.  गोपनीयता और भेदभाव

3.  एक्सेस कंट्रोल

4.  रद्द करने योग्य बायोमेिट्रक्स

   

Question Number : 10 Question Id : 25498930919 Question Type : MCQ Option Shuffling : Yes 



Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is NOT a function of System bus?

Options :

1.  Data Sharing

2.  Addressing

3.  Power

4.  Connects memory to disk

   

Question Number : 10 Question Id : 25498930919 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्निलिखत में से कौन सा िसस्टम बस का कायर् नहीं है?

Options :

1.  डाटा शेयिरंग

2.  एडे्रिसंग

3.  पावर

4.  मेमोरी को िडस्क से जोड़ता है

   

Question Number : 11 Question Id : 25498931289 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is NOT a characteristic of impact printers?

Options :



1.  Reliable printers and inexpensive

2.  Not noisy

3.  Make continuous prints on paper

4.  The cost of printouts is cheaper

   

Question Number : 11 Question Id : 25498931289 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्न में से कौन सी इम्पकै्ट िप्रंटरों की एक िवशेषता नहीं है?

Options :

1.  िरलाएबल िप्रंटसर् एडं इनएक्सपेंिसवे

2.  ये शोर नहीं करते हैं

3.  कागज पर लगातार िप्रंट करते हैं

4.  िप्रटंआउट की लागत सस्ती है

   

Question Number : 12 Question Id : 25498932661 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is a type of reader uses radio frequency to communicate, when the card is 

bought close to the reader?

Options :

1.  Seamless card reader

2.  Design card reader

3.  Graphics card reader



4.  Contactless card reader

   

Question Number : 12 Question Id : 25498932661 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

काडोर्ं को जब रीडर के पास लाया जाता है, तो रीडर संचार के िलए िनम्निलिखत में से िकस रेिडयो आवृित्त का उपयोग करते हैं?

Options :

1.  सीमलेस काडर् रीडर

2.  िडज़ाइन काडर् रीडर

3.  ग्रािफ़क्स काडर् रीडर

4.  कॉन्टैक्टलेस काडर् रीडर

   

Question Number : 13 Question Id : 25498933101 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

A passive digital tablet generates a(n) ______. This signal is received by the LC circuit in the stylus. 

Options :

1.  analog signal

2.  digital signal

3.  electromagnetic signal

4.  electrical signal

   

Question Number : 13 Question Id : 25498933101 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0

पैिसव िडिजटल टैबलेट एक ______ उत्पन्न करता है। यह िसग्नल LC पिरपथ में स्टाइलस द्वारा ग्रहण िकया जाता है। 

Options :

1.  एनालॉग िसग्नल

2.  िडिजटल िसग्नल

3.  िवद्युतचुंबकीय िसग्नल

4.  िवद्युत िसग्नल

   

Question Number : 14 Question Id : 25498933202 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

What will be the result of addition of given binary numbers (101)2 and (11)2?

Options :

1.  1110

2.  1101

3.  1000

4.  0111

   

Question Number : 14 Question Id : 25498933202 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

दी गई िद्वआधारी संख्याओं (101)2 और (11)2 को जोड़ने का पिरणाम क्या होगा?

Options :

1.  1110



2.  1101

3.  1000

4.  0111

   

Question Number : 15 Question Id : 25498933834 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

What is the full form of SSD with reference to storage devices of a computer?

Options :

1.  Solid State Drive

2.  Structure State Drive

3.  Synchronous State Drive

4.  Solid Synchronous Drive

   

Question Number : 15 Question Id : 25498933834 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

कंप्यूटर की स्टोरेज िडवाइस के संदभर् में SSD का पूणर्रूप क्या है? 

Options :

1.  सॉिलड स्टेट ड्राइव (Solid State Drive)

2.  स्ट्रक्चर स्टेट ड्राइव (Structure State Drive)

3.  िसकं्रोनस स्टेट ड्राइव (Synchronous State Drive)

4.  सॉिलड िसंक्रोनस ड्राइव (Solid Synchronous Drive)

   



Question Number : 16 Question Id : 2549898171 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

______ refers to the hacking or deception that imitates another person with the intentions of 

bypassing security measures.

Options :

1.  Spoof

2.  Access

3.  Firewall

4.  Virus

   

Question Number : 16 Question Id : 2549898171 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

__________ हैिकंग या धोखे को संदिभंत करता है जो सुरक्षा उपायों को दरिकनार करने के इरादे से िकसी अन्य व्यिक्त का अनुकरण 

(नकल) करता है।

Options :

1.  स्पूफ़

2.  पहुँच (एक्सेस)

3.  फ़ायरवॉल

4.  वायरस

   

Question Number : 17 Question Id : 2549899452 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0



________  is a small program that starts when the computer is booting, in order to find the 

operating system

Options :

1.  CMOS

2.  Fan

3.  Compiler

4.  The Master Boot Record (MBR)

   

Question Number : 17 Question Id : 2549899452 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

__________ एक छोटा सा प्रोग्राम है जो ऑपरेिटंग िसस्टम को खोजने के िलए कंप्यूटर के बूट होने पर शरुू होता है।

Options :

1.  CMOS

2.  पंखा (Fan)

3.  संकलक (Compiler)

4.  मास्टर बूट िरकॉडर् (MBR)

   

Question Number : 18 Question Id : 2549899470 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In MS-Excel, in which category of functions does FREQUENCY command belongs to?

Options :

1.  Statistical



2.  Engineering

3.  Math and Trigonometry

4.  Text

   

Question Number : 18 Question Id : 2549899470 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-Excel में, FREQUENCY कमांड िकस श्रेणी के फंक्शन से संबंिधत है?       

Options :

1.  सािंख्यकीय

2.  इंजीिनयिरंग

3.  गिणत और ित्रकोणिमित

4.   टेक्स्ट

   

Question Number : 19 Question Id : 2549899573 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

James Gosling is generally known best as the founder or creator of the ______ programming 

language.

Options :

1.  JAVA

2.  C

3.  C++

4.  COBOL



   

Question Number : 19 Question Id : 2549899573 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

जेम्स गोसिलंग को आम तौर पर ______ प्रोग्रािमंग भाषा के संस्थापक या िनमार्ता के रूप में जाना जाता है।

Options :

1.  JAVA

2.  C

3.  C++

4.  COBOL

   

Question Number : 20 Question Id : 25498910788 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The printer is a device used to produce:

Options :

1.  hardcopy

2.  softcopy

3.  copy on disk

4.  copy on CD

   

Question Number : 20 Question Id : 25498910788 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िप्रंटर एक उपकरण है िजसका उपयोग _______ उत्पादन के िलए िकया जाता है।



Options :

1.  हाडर्कॉपी

2.  सॉफ्टकॉपी

3.  िडस्क पर कॉपी करें (copy on disk)

4.  सीडी पर कॉपी (copy on CD)

   

Question Number : 21 Question Id : 25498911251 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Virtual memory is ______.

Options :

1.  Large optical device memory

2.  Secondary memory can be used as if it were a part of the main memory

3.  Large disk memory

4.  Large secondary memory

   

Question Number : 21 Question Id : 25498911251 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

वचुर्अल मेमोरी _______ है।

Options :

1.  लाजर् ऑिप्टकल िडवाइस मेमोरी

2.  सेकें डरी मेमोरी का उपयोग इस तरह िकया जा सकता है जैसे िक वह मुख्य मेमोरी का एक िहस्सा हो

3.  लाजर् िडस्क मेमोरी



4.  लाजर् सकेें डरी मेमोरी

   

Question Number : 22 Question Id : 25498913391 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

_______ is the main register in the ALU and contains one of the operands of an operation to be 

performed in the ALU.

Options :

1.  RAM

2.  ROM

3.  Memory

4.  Accumulator

   

Question Number : 22 Question Id : 25498913391 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

_______ ALU में मुख्य रिजस्टर है और इसमें ALU में िकए जाने वाले ऑपरेशन के ऑपरेंड में से एक होता है।

Options :

1.  रेम (RAM)

2.  रोम (ROM)

3.  मेमोरी (Memory)

4.  संचायक (Accumulator)

   

Question Number : 23 Question Id : 25498913457 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 



: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is an input device?

Options :

1.  Speaker

2.  Word

3.  Scanner

4.  Printer

   

Question Number : 23 Question Id : 25498913457 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्निलिखत में से कौन-सा, एक इनपुट िडवाइस है?

Options :

1.  स्पीकर

2.  वडर्

3.  स्कैनर

4.  िप्रटंर

   

Question Number : 24 Question Id : 25498913947 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

_______ is a feature in Windows 7, Windows 8, or Windows 10 that  enables user to get back to the 

desktop swiftly.

Options :



1.  Aero Peek

2.  Home Button

3.  Windows

4.  M Key

   

Question Number : 24 Question Id : 25498913947 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

_______, िवंडोज 7, िवंडोज 8 या िवंडोज 10 में एक फीचर होता है जो उपयोगकतार् को डेस्कटॉप पर तेजी से वापस आने में सक्षम 

बनाता है।

Options :

1.  एयरो पीक (Aero Peek)

2.  होम बटन (Home Button)

3.  िवडंोज़ (Windows)

4.  M कुंजी (M Key)

   

Question Number : 25 Question Id : 25498918461 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Choose the ROM type in which electric field is applied to erase data?

Options :

1.  MROM

2.  PROM

3.  EPROM



4.  EEPROM

   

Question Number : 25 Question Id : 25498918461 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

वह ROM प्रकार चुनें िजसमें डेटा िमटाने के िलए िवद्युत क्षेत्र लगाया जाता है?

Options :

1.  MROM

2.  PROM

3.  EPROM

4.  EEPROM

   

Question Number : 26 Question Id : 25498918559 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

To access the services of the operating system, the interface is provided by the _______.

Options :

1.  Memory

2.  System Calls

3.  Client

4.  Administrator

   

Question Number : 26 Question Id : 25498918559 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0

ऑपरिेटंग िसस्टम की सेवाओं तक पहुंचने के िलए, इंटरफे़स _______ द्वारा प्रदान िकया जाता है.

Options :

1.  मेमोरी

2.  िसस्टम कॉल्स

3.  क्लाइंट

4.  एडिमिनस्टे्रटर

   

Question Number : 27 Question Id : 25498922018 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In DES, due to the _____________ a small change in the plaintext results in a very great change in the 

ciphertext.

Options :

1.  Iris effect

2.  Gabber effect

3.  Avalanche effect

4.  Newton effect

   

Question Number : 27 Question Id : 25498922018 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

डी.ई.एस. (DES) में ___ के कारण प्लेनटेक्स्ट में छोटा सा बदलाव साइफरटेक्स्ट में बहुत बड़ा पिरवतर्न लाता है।

Options :

1.  आइिरस प्रभाव



2.  गैबर प्रभाव

3.  ऐव़लान्श् (Avalanche) प्रभाव

4.  न्यूटन प्रभाव

   

Question Number : 28 Question Id : 25498924170 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In Linux, which command is used to record a user login session in a file?

Options :

1.  macro

2.  read

3.  script

4.  login

   

Question Number : 28 Question Id : 25498924170 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िलनक्स में, िकस कमांड का प्रयोग िकसी फाइल में यूजर लॉिगन सेशन को िरकॉडर् करने के िलए िकया जाता है?

Options :

1.  मैक्रो

2.  रीड

3.  िस्क्रप्ट

4.  लॉिगन

   



Question Number : 29 Question Id : 25498925391 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In MS-Excel, In which category of functions does "IFERROR" belongs to?

Options :

1.  Statistical

2.  Lookup and Reference

3.  Text

4.  Logical

   

Question Number : 29 Question Id : 25498925391 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-Excel में, "IFERROR" िकस श्रेणी के फं़क्शन से संबंिधत है?

Options :

1.  स्टैिटिस्टकल

2.  लुकअप एडं िरफरेन्स

3.  टेक्स्ट

4.  लॉिजकल

   

Question Number : 30 Question Id : 25498925426 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In MS-Excel, In which category of functions does "HEX2BIN" belongs to?



Options :

1.  Math and trigonometry

2.  Statistical

3.  Text

4.  Engineering

   

Question Number : 30 Question Id : 25498925426 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-Excel में, "HEX2BIN" िकस श्रेणी के फंक्शन से संबंिधत है?  

Options :

1.  गिणत और ित्रकोणिमित

2.  सािंख्यकीय

3.  टेक्स्ट (Text)

4.  इंजीिनयिरंग (Engineering)

   

Question Number : 31 Question Id : 2549896748 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is NOT an example of E-commerce?

Options :

1.  Sending an email to your friend

2.  A government employee reserving a hotel room over the internet

3.  An individual paying his electricity bill through the Internet



4.  An individual purchasing a book over the Internet

   

Question Number : 31 Question Id : 2549896748 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्निलिखत में से कौन-सा, ई-कॉमसर् का एक उदाहरण नहीं है?

Options :

1.  आपके िमत्र को कोई ई-मेल भेजना।

2.  इंटरनेट पर िकसी सरकारी कमर्चारी द्वारा होटल का कोई कमरा आरिक्षत करना।

3.  इंटरनेट के जिरये िकसी व्यिक्त द्वारा अपने िबजली िबल का भुगतान करना।

4.  इंटरनेट पर िकसी व्यिक्त द्वारा पुस्तक खरीदना।

   

Question Number : 32 Question Id : 2549897218 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The process of copying a document from your Google Drive account to your flash drive is called:

Options :

1.  netload

2.  upload

3.  download

4.  link load

   

Question Number : 32 Question Id : 2549897218 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0

िकसी डोक्युमेंट को आपके Google ड्राइव खाते से आपके फ्लैश ड्राइव में कॉपी करने की प्रिक्रया क्या कहलाती है?

Options :

1.  नेटलोड

2.  अपलोड

3.  डाउनलोड

4.  िलकं लोड

   

Question Number : 33 Question Id : 2549897803 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following provides Internet access to users?

Options :

1.  TCP

2.  ISP

3.  FTP

4.  HTTP

   

Question Number : 33 Question Id : 2549897803 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्न में से कौन-सा, उपयोगकतार्ओं को इंटरनेट एक्सेस प्रदान करता है?

Options :

1.  TCP



2.  ISP

3.  FTP

4.  HTTP

   

Question Number : 34 Question Id : 2549897950 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Assembly language is a ______ programming language.

Options :

1.  high-level

2.  low-level

3.  medium-level

4.  machine

   

Question Number : 34 Question Id : 2549897950 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

असेंबली भाषा एक ______ प्रोग्रािमंग भाषा है।

Options :

1.  उच्च-स्तरीय

2.  िनम्न-स्तरीय

3.  मध्यम-स्तरीय

4.  मशीन

   



Question Number : 35 Question Id : 2549899020 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

What is the full form of VSAT?

Options :

1.  Very Small Aperture Terminal

2.  Very Small Alternative Terminal

3.  Very Small Asynchronous Trading

4.  Very Small Aggressive Terminal

   

Question Number : 35 Question Id : 2549899020 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

VSAT का पणूर् रूप क्या है?

Options :

1.  Very Small Aperture Terminal (वेरी स्मॉल अपचर्र टिमंनल)

2.  Very Small Alternative Terminal (वेरी स्मॉल अल्टनेर्िटव टिमंनल)

3.  Very Small Asynchronous Trading (वेरी स्मॉल अिसंक्रोनस टे्रिडंग)

4.  Very Small Aggressive Terminal (वेरी स्मॉल अग्रेिसव टिमंनल)

   

Question Number : 36 Question Id : 25498910444 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The toggle case applied to “aBraCaDabra is -



Options :

1.  ABraCaDabrA

2.  abracaDabra

3.  aBracadabra

4.  AbRAcAdABRA

   

Question Number : 36 Question Id : 25498910444 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

"aBraCaDabra" पर लागू होने वाला टॉगल केस है -

Options :

1.  ABraCaDabrA

2.  abracaDabra

3.  aBracadabra

4.  AbRAcAdABRA

   

Question Number : 37 Question Id : 25498910678 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

A(n) _______________ section break starts a new section on the same page in MS-Word.

Options :

1.  next page

2.  continuous

3.  even page



4.  odd page

   

Question Number : 37 Question Id : 25498910678 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

एक ______ सेक्शन ब्रेक MS-Word में उसी पेज पर एक नया सेक्शन शरुू करता है।

Options :

1.  नेक्स्ट पेज

2.  कंटीन्यूअस

3.  इवन पेज

4.  ऑड पेज

   

Question Number : 38 Question Id : 25498910740 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following options makes a search task case sensitive in the 'Find & Replace' dialog 

box?

Options :

1.  String sensitive

2.  Match string

3.  Case sensitive

4.  Match case

   

Question Number : 38 Question Id : 25498910740 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 



: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्निलिखत में से कौन-सा िवकल्प 'Find & Replace' डायलॉग बॉक्स में खोज कायर् (सचर् टास्क) केस सेंिसिटव बनाता है?

Options :

1.  िस्टं्रग सेंिसिटव (String sensitive)

2.  मैच िस्टं्रग (Match string)

3.  केस सेंिसिटव (Case sensitive)

4.  मैच केस (Match case)

   

Question Number : 39 Question Id : 25498911482 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In MS-Word, the keyboard shortcut to open the Thesaurus task pane of Proofing tab is 

________________.

Options :

1.  Alt + Click

2.  F7

3.  Shift + F7

4.  Ctrl + Click

   

Question Number : 39 Question Id : 25498911482 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-Word में, अशुिद्ध जांच (प्रूिफंग टैब) के िथसॉरस टास्क पेन को खोलने के िलए कीबोडर् शॉटर्कट __________ है।

Options :



1.  Alt + िक्लक

2.  F7

3.  Shift + F7

4.  Ctrl + िक्लक

   

Question Number : 40 Question Id : 25498911498 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is NOT a valid Windows operating system version?

Options :

1.  Windows XP

2.  Windows 95

3.  Windows 98

4.  Windows 99

   

Question Number : 40 Question Id : 25498911498 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्निलिखत में से कौन-सा, वैध िवंडोज ऑपरेिटंग िसस्टम संस्करण नहीं है?

Options :

1.  Windows XP

2.  Windows 95

3.  Windows 98

4.  Windows 99



   

Question Number : 41 Question Id : 25498911844 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is NOT an option for Paragraph spacing in MS-Word.

Options :

1.  Tight

2.  Compact

3.  Double

4.  Close

   

Question Number : 41 Question Id : 25498911844 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-Word में पैराग्राफ स्पेिसंग के िलए िनम्निलिखत में से कौन सा िवकल्प नहीं है।

Options :

1.  टाइट

2.  कॉम्पकै्ट

3.  डबल

4.  क्लोज

   

Question Number : 42 Question Id : 25498911872 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0



If there are multiple reviewers of an MS-Word document, each person will be assigned 

_____________ markup color for track changes.

Options :

1.  a different

2.  the same

3.  a default

4.  red

   

Question Number : 42 Question Id : 25498911872 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

यिद MS-Word दस्तावेज़ के कई समीक्षक (reviewers) हैं, तो प्रत्येक व्यिक्त को टै्रक पिरवतर्नों के िलए ____________ माकर् अप रंग 

िदया जाएगा।

Options :

1.  िविभन्न

2.  समान

3.  िडफ़ॉल्ट

4.  लाल

   

Question Number : 43 Question Id : 25498911893 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The given commands are a part of the _________ group in the Review tab of MS-Word. 



Options :

1.  Proofing

2.  Comments

3.  Tracking

4.  Changes
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िदए गए कमांड एमएस-वडर् के िरव्यू टैब में ________ ग्रुप का िहस्सा हैं। 

Options :

1.  प्रूिफंग (Proofing)

2.  कमेंट्स (Comments)

3.  टै्रिकंग (Tracking)

4.  चेंिजस (Changes)
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What is the full form of SMPS with reference to PC operation?

Options :

1.  Switched Mode Power Supply

2.  Synchronous Mode Power Supply

3.  Switch Method Power Supply

4.  Switch Mode Power Supplement
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PC ऑपरेशन के संदभर् में SMPS का पूणर् रूप क्या है?

Options :

1.  िस्वचएड मोड पावर सप्लाय (Switched Mode Power Supply)

2.  िसकं्रोनस मोड पावर सप्लाय (Synchronous Mode Power Supply)

3.  िस्वच मेथड पावर सप्लाय (Switch Method Power Supply)

4.  िस्वच मोड पावर सप्लीमेंट (Switch Mode Power Supplement)
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In MS-Word, the option which is NOT available in “Start Mail Merge” is-

Options :

1.  Envelopes



2.  Labels

3.  Letters

4.  Pages
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MS-Word में “Start Mail Merge” में जो िवकल्प उपलब्ध नहीं होता है, वह है-

Options :

1.  िलफाफे (Envelopes)

2.  लेबल (Labels)

3.  पत्र (Letters)

4.  पृष्ठों (Pages)
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Which of the following is a convenient resting place for the most frequently used commands in 

MS-Word?

Options :

1.  Document area

2.  Status bar

3.  File tab

4.  Quick Access Toolbar
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िनम्निलिखत में से कौन-सा MS-Word में सबसे अिधक (बार - बार) उपयोग िकए जाने वाले कमांड के िलए सुिवधाजनक िवश्राम 

स्थल (resting place) है?

Options :

1.  डोक्युमेंट क्षेत्र (Document area)

2.  स्टेटस बार (Status bar)

3.  फ़ाइल टैब (File tab)

4.  िक्वक एक्सेस टूलबार (Quick Access Toolbar)
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In MS-Word, ____________ mode is used to hide the writing tools and menus and to leave more 

room for the pages themselves.

Options :

1.  Read

2.  Write

3.  Draft

4.  Print Layout
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MS-Word में, ________ मोड का उपयोग राइिटंग टूल्स और मेनू को िछपाने के िलए और स्वयं पृष्ठों के िलए अिधक जगह छोड़ने के 

िलए िकया जाता है।

Options :

1.  रीड (Read)

2.  राइट (Write)

3.  ड्राफ्ट (Draft)

4.  िप्रटं लेआउट (Print Layout)

   

Question Number : 48 Question Id : 25498920558 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 
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There are many ways to insert a page number in an MS-Word document. Which of the following 

steps lets you insert a page number?

Options :

1.  Page Number from Insert menu

2.  Page Setup from File menu

3.  Footnote from Insert menu

4.  Page Number from Design menu
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MS-Word डॉक्यूमेंट में, पेज संख्या इन्सटर् करने के कई तरीके हो सकते हैं। िनम्निलिखत में से कौन-सा चरण आपको पेज सखं्या 



इन्सटर् करने में सहायता करता है?

Options :

1.  इन्सटर् मेनू से पेज सखं्या (Page Number from Insert menu)

2.  फाइल मेनू से पेज सेटअप (Page Setup from File menu)

3.  इन्सटर् मेनू से फुटनोट (Footnote from Insert menu)

4.  िडजाईन मेनू से पेज सखं्या (Page Number from Design menu)

   

Question Number : 49 Question Id : 25498923918 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 
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The task performed by the "Wrap Text” feature in MS-Word is?

Options :

1.  It inserts spaces between words

2.  It aligns text with the right margin

3.  It forces all text to be confined within defined margins

4.  It combines and centres the content of the selected cells
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MS-Word में "Wrap Text" फीचर द्वारा िकया जाने वाला कायर् है?

Options :

1.  यह शब्दों के बीच िरिक्त (स्पेस) जोड़ता है।

2.  यह दाई मािजंन के साथ टेक्स्ट को संरेिखत करता है।



3.  यह पिरभािषत मािजंन के भीतर सभी टेक्स्ट को सीिमत कर देता है।

4.  यह चयिनत सेल की सामग्री को जोड़ता है और कें िद्रत करता है।
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Ashish wants to install a flash player from the Internet where the setup link is available. Which 

process should he use to save the setup on his computer?

Options :

1.  Downloading

2.  Uploading

3.  Reloading

4.  Indexing
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आशीष इंटरनेट से एक फ्लैश प्लयेर स्थािपत (install) करना चाहता है जहां सेटअप िलंक उपलब्ध है। सेटअप को अपने कंप्यटूर पर 

सेव करने के िलए उसे िकस प्रिक्रया का उपयोग करना चािहए? 

Options :

1.  डाउनलोिडंग

2.  अपलोिडंग

3.  री-लोिडंग

4.  इंडेिक्संग
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An anonymous FTP server allows you to only ______ the files on the client machine without creating 

any account.

Options :

1.  download

2.  upload

3.  execute

4.  delete
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एक अनाम (anonymous) FTP सवर्र आपको िबना कोई खाता बनाए क्लाइंट मशीन पर केवल फाइलों को ______ करने की 

अनुमित देता है। 

Options :

1.  डाउनलोड

2.  अपलोड

3.  एक्जीक्युट

4.  िडलीट
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Who among the following introduced the first commercial hard disk?

Options :

1.  Dell

2.  IBM

3.  Microsoft

4.  Intel
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िनम्निलिखत में से िकसने पहली कमिशंयल हाडर् िडस्क पेश की थी?

Options :

1.  डेल (Dell)

2.  आईबीएम (IBM)

3.  माइक्रोसॉफ्ट (Microsoft)

4.  इन्टेल (Intel)
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Question Numbers : (53 to 57)

Read the given passage and answer the questions. 

Tom Sawyer 

 

Tom was not feeling well. He could not sleep as well as he used to. He could not eat as much as he 

used to. He did not want to run away from school. Sometimes he did not want to play. He was 

troubled and sad. 

“The boy is ill,” Aunt Polly thought. “I must give him some medicine.” 

Aunt Polly was fond of all kinds of medicines. She had a lot of books on this subject. Her newest 

idea was this– when a boy was ill, he must bathe in cold water every day. And so, every morning, 

she made Tom stand outside in the yard. Then, she threw ice-cold water on him. After that, she 

wrapped him in a wet blanket and made him lie in bed. Tom did not get better. He got worse. Aunt 

Polly tried a new idea. She threw hot water on him instead of cold. That did not help Tom either. 

At this time, Aunt Polly heard of a new medicine. It was called Pain-killer. It had the taste of fire. All 

the same, Aunt Polly made Tom drink it– three spoonfuls after each meal. Tom hated it. When his 

aunt was not looking, he quickly poured the medicine into a hole in the floor. Tom was busy doing 

this one day when the cat came in. Tom poured some of the medicine into its mouth. At once, it 

jumped high into the air. It started dancing on its back legs. It ran about as if it were mad. Tom 



laughed and laughed. It was a long time since he had laughed so heartily. Aunt Polly heard the 

noise and came rushing in. 

“What’s the matter?” 

Tom couldn’t speak for laughing. At last, he pointed and said, “Look, look at the cat.” 

“What’s the matter with it? You’ve been giving it that medicine?” 

“I don’t know,” said Tom, still laughing. 

Aunt Polly saw the bottle of Pain-killer and the spoon. She guessed the truth. 

Tom expected Aunt Polly to be angry. To his surprise, she was only thoughtful. “It’s not for cats,” 

she said, “perhaps it’s not a good medicine for boys. You needn’t take any more of it, Tom.”

Sub questions
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What indicated that Tom was not well?

Options :

1.  He didn’t talk to his aunt.

2.  He didn’t play with the cat.

3.  He didn’t eat properly.

4.  He didn’t go to school.
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After throwing ice-cold water on Tom, Aunt Polly ______________.

Options :

1.  bathed him in hot water.



2.  made him lie in bed.

3.  gave him three spoonfuls of medicine

4.  wrapped him in a wet blanket
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After taking the medicine, the cat did NOT ___________.

Options :

1.  jump into the air.

2.  dance on its back legs.

3.  go to sleep.

4.  run as if it were mad.
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How did Aunt Polly react when she saw the cat?

Options :

1.  She was surprised.

2.  She was thoughtful.

3.  She was angry.

4.  She was scared.
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‘She guessed the truth’. What was the truth?

Options :

1.  The medicine was not good for boys.

2.  The medicine had the taste of fire.

3.  The bottle of Pain-killer was empty.

4.  Tom had given the medicine to the cat.
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Question Numbers : (53 to 57)

िदए गए गद्यांश को पढ़ें  और उसके आधार पर प्रश्नों के उत्तर दें। 

टॉम सॉयर 

टॉम स्वस्थ महसूस नहीं कर रहा था। वह उतना सो नहीं सका िजतना वह सो सकता था। वह उतना खा नहीं सका िजतना वह खा सकता 

था। वह स्कूल से भागना नहीं चाहता था। कभी-कभी वह खेलना नहीं चाहता था। वह परेशान और उदास था। 

चाची पोली को लगा, "लड़का बीमार है।" "मुझे उसे कुछ दवा देनी चािहए।" 

चाची पोली को सभी प्रकार की दवाओं की जानकारी थी। इस िवषय पर उनके पास बहुत सारी िकताबें थीं। उनका सबसे नया िवचार यह 

था - जब लड़का बीमार हो, उसे हर िदन ठंडे पानी से स्नान करना चािहए। और इसिलए हर सुबह उन्होंने टॉम को याडर् में बाहर खड़ा कर 

िदया। िफर उन्होंने उस पर बफीर्ला-ठंडा पानी फें क िदया। उसके बाद, उन्होंने उसे गीले कंबल में लपेट िलया और उसे िबस्तर पे सुला 

िदया। टॉम बेहतर नहीं हुआ। वह बदतर हो गया। चाची पोली ने नए िवचार की कोिशश की। उन्होंने उसपर ठंडे के बजाय गमर् पानी फें क 

िदया। इससे भी टॉम को मदद नहीं िमली। 

उसी समय चाची पोली ने एक नई दवा के बारे में सुना। इसे पेन-िकलर कहा जाता था। इसमें तेज स्वाद था। इसे चाची पोली ने टॉम को 

िपला िदया। चाची पोली वह दवाई टॉम को प्रत्येक भोजन के बाद तीन चम्मच िपलाती थीं। टॉम इससे नफरत करता था। जब उसकी 

चाची नहीं देख रही थी, तो उसने तुरंत दवा को फशर् में एक छेद में डाल िदया। एक िदन टॉम ऐसा करने में व्यस्त था तब िबल्ली आई। 

टॉम ने उसके मुंह में कुछ दवा डाल दी। तुरंत उसने हवा में छलांग लगाईं। उसने अपने पीछे के पैरों पर नृत्य करना शरुू कर िदया। वह 

दौड़ गई जैसे िक वह पागल हो गई थी। टॉम हंस कर पागल हो गया। वह बहुत िदन बाद इतना खुलकर हँसा था। चाची पोली शोर सुनकर 

अंदर आई। 

"क्या बात है?" 



टॉम हँसते-हँसते इतना लोट-पोट हो गया िक बात नहीं कर सका। अंत में उसने इंिगत िकया और कहा, "देखो, िबल्ली को देखो।" 

"क्या हुआ है? तुम इसे वह दवा दे रहे हो? " 

टॉम ने कहा, "मुझे नहीं पता," वह अभी भी हंस रहा था। 

चाची पोली ने पेन-िकलर की बोतल और चम्मच देखी। उसने सच्चाई का अनुमान लगाया। 

टॉम को लगा, चाची गुस्सा हो गई। पर आश्चयर् िक वह केवल िवचारशील थी। "यह िबिल्लयों के िलए नहीं है," उसने कहा, "शायद यह 

लड़कों के िलए अच्छी दवा नहीं है। तुम्हें इसे और अिधक नहीं लेना चािहए, टॉम। "

Sub questions

 

Question Number : 53 Question Id : 25498921146 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

कैसे पता चला िक टॉम ठीक नहीं था?

Options :

1.  उसने अपनी चाची से बात नहीं की।

2.  वह िबल्ली के साथ नहीं खेलता था।

3.  उसने ठीक से खाया नहीं था।

4.  वह स्कूल नहीं गया था।
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टॉम पर बफीर्ला ठंडा पानी फें कने के बाद, आंट पोली ने ______ ।

Options :

1.  उसे गमर् पानी में नहाया

2.  उसे िबस्तर में िलटाया

3.  उसे तीन चम्मच दवा दी



4.  उसे गीले कंबल में लपेटा
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Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

दवा लेने के बाद िबल्ली ने क्या नहीं िकया?

Options :

1.  हवा में कूदी।

2.  अपने पीछे के पैरों से नृत्य िकया।

3.  सो गई।

4.  ऐसे दौड़ी जैसे िक वह पागल हो गई हो।

 

Question Number : 56 Question Id : 25498921149 Question Type : MCQ Option Shuffling : Yes 
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Correct Marks : 1 Wrong Marks : 0

जब चाची पोली ने िबल्ली को देखा तो कैसी प्रितिक्रया दी?

Options :

1.  वह हैरान थी।

2.  वह िवचारशील थी।

3.  वह गुस्से में थी।

4.  वह डर गयी थी।

 

Question Number : 57 Question Id : 25498921150 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0

'उसने सच्चाई का अनुमान लगाया'। सच क्या था?

Options :

1.  दवा लड़कों के िलए अच्छी नहीं थी।

2.  दवा का स्वाद तेज़ था।

3.  पेन-िकलर की बोतल खाली थी।

4.  टॉम ने िबल्ली को दवा दी थी।
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: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

A basket contains 4 red, 5 blue and 3 green marbles. If two marbles are drawn at random, what is 

the probability that both are red?

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 58 Question Id : 25498928783 Question Type : MCQ Option Shuffling : Yes 
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एक टोकरी में 4 लाल, 5 नीले और 3 हरे कंचे हैं। यिद दो कंचे यादृिच्छक रूप से िनकाले जाते हैं, तो उन दोनों के लाल होने की 

प्राियकता क्या है?

Options :

1.   

 

2.   

 



3.   

 

4.   
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What is the value of the given expression? 

25 × 3.25 + 50.4 ÷ 24

Options :

1.  84.50

2.  83.35

3.  83.53

4.  82.45
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Options :

1.   

 



2.   

 

3.   

 

4.   
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Options :

1.  4 लीटर

2.  8 लीटर

3.  10 लीटर

4.  12 लीटर

   

Question Number : 60 Question Id : 25498929048 Question Type : MCQ Option Shuffling : Yes 
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18 litres of pure water was added to a vessel containing 80 litres of pure milk. 49 litres of the 

resultant mixture was then sold and some more quantity of pure milk and pure water was added 

to the vessel in the ratio of 2 : 1. If the resultant ratio of milk to water in the vessel was 4 : 1, what 

was the quantity of pure milk added to the vessel?



Options :

1.  4 litres

2.  8 litres

3.  10 litres

4.  12 litres
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Select the number from among the given options that can replace the question mark (?) in the 

following series. 

6, 5, 8, 21, 80, ?

Options :

1.  268

2.  192

3.  255

4.  395
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Options :

1.   



 

2.   

 

3.   

 

4.   
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Select the option that can replace the question mark (?) in the given equation. 

30% of 1240 + 20% of 2480 – 248 = ?% of 620

Options :

1.  100

2.  50

3.  200

4.  400
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Options :



1.   

 

2.   

 

3.   

 

4.   
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Correct Marks : 1 Wrong Marks : 0

Options :

1.  2

2.  3

3.  5

4.  7
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Options :

1.   



 

2.   

 

3.   

 

4.   
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Correct Marks : 1 Wrong Marks : 0

Which of the following words will come third if they are arranged as per their order in an English 

dictionary?

Options :

1.  Nature

2.  Native

3.  Narrate

4.  Nascent
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िनम्निलिखत में से कौन-सा शब्द अंग्रेजी शब्दकोश में उनके क्रम के अनुसार व्यविस्थत होने पर तीसरे स्थान पर आएगा?

Options :

1.  Nature

2.  Native

3.  Narrate

4.  Nascent

   

Question Number : 65 Question Id : 25498914067 Question Type : MCQ Option Shuffling : Yes 
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Correct Marks : 1 Wrong Marks : 0

अक्षरों का एक समूह िदया गया है, अक्षर क्रमशः बाए ंसे दाए ं(a), (b), (c), (d), (e), (f), (g) और (h) के रूप में इंिगत िकये गये हैं। 

आठ अक्षर का एक साथर्क शब्द बनाने के िलए अक्षरों को व्यविस्थत करें और अपने उत्तर के रूप में अंितम अक्षर के सूचक को इंिगत 

करें। 

 



h r c a b l o e (a) (b) (c) (d) (e) (f) (g) (h)

Options :

1.  (a)

2.  (b)

3.  (c)

4.  (d)

   

Question Number : 65 Question Id : 25498914067 Question Type : MCQ Option Shuffling : Yes 
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Correct Marks : 1 Wrong Marks : 0

A group of letters is given; the letters are indexed as (a), (b), (c), (d), (e), (f), (g) and (h), respectively, 

from left to right. Arrange the letters properly to form a meaningful eight-letter word and indicate 

the index of the last letter as your answer. 

 

h r c a b l o e (a) (b) (c) (d) (e) (f) (g) (h)

Options :

1.  (a)

2.  (b)

3.  (c)

4.  (d)
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Select the option in which the words share the same relationship as that shared by the given set of 

words. 



 

Picture : Clock : Wall

Options :

1.  Pillow : Quilt : Bed

2.  Pen : Pencil : Colour

3.  Flowers : Garden : Park

4.  Footpath : Road : Highway

   

Question Number : 66 Question Id : 25498919651 Question Type : MCQ Option Shuffling : Yes 
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उस िवकल्प का चयन करें िजसमें शब्द वही संबंध साझा करते हैं जो िदए गए समुच्चय के शब्दों के द्वारा साझा िकया गया हैं। 

 

िचत्र : घड़ी : दीवार

Options :

1.  तिकया : रज़ाई : चारपाई

2.  कलम : पेंिसल : रंग

3.  फूल : बगीचा: उद्यान

4.  फुटपाथ : सड़क : राजमागर्
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Select the option in which the numbers share the same relationship as that shared by the given 

pair of numbers. 

 



11 : 1210 

 

(NOTE : Operations should be performed on the whole numbers, without breaking down the 

numbers into its constituent digits. E.g., 1,3 – Operations on 13 such as adding 

/subtracting/multiplying etc. to 13 can be performed. Breaking down 13 into 1 and 3 and 

then performing mathematical operations on 1 and 3 is not allowed)

Options :

1.  6 ∶ 226

2.  7 ∶ 1129

3.  8 ∶ 448

4.  9 ∶ 739

   

Question Number : 67 Question Id : 25498919687 Question Type : MCQ Option Shuffling : Yes 
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Correct Marks : 1 Wrong Marks : 0

उस िवकल्प का चयन करें िजसमें संख्याए ंवही संबंध साझा करती हैं जो िदए गए संख्याओं के युग्म द्वारा साझा िकया गया है। 

 

11 : 1210 

 

(नोट: संख्याओं को उसके घटक अंकों में तोडे़ िबना, संपूणर् संख्याओं पर संिक्रयाए ंकी जानी चािहए। उदाहरण के िलए 1,3 – 13 पर 

संिक्रयाए ंजैसे िक 13 में जोड़ना/घटाना/गुणा करना आिद की जा सकती हैं। 13 को 1 और 3 में िवघिटत करना  और िफर 1 और 3 पर 

गिणतीय संिक्रयाए ँकरने की अनुमित नहीं है)

Options :

1.  6 ∶ 226

2.  7 ∶ 1129

3.  8 ∶ 448

4.  9 ∶ 739
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शब्दों के चार जोडे़ िदए गए हैं, िजनमें से तीन िकसी तरह से समान हैं और एक अलग है। जो अलग है उसे चुनें.

Options :

1.  बॉिक्संग : िरंग

2.  स्केिटगं : िरंग

3.  टेिनस : कोटर्

4.  हॉकी : िपच
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Four pair of words have been given, out of which three are alike in some manner and one is 

different. Select the one that is different.

Options :

1.  Boxing: Ring

2.  Skating: Ring

3.  Tennis: Court

4.  Hockey: Pitch
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Options :

1.  16

2.  17

3.  18

4.  19
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Options :

1.  16

2.  17

3.  18

4.  19
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भारत में, उदार औद्योिगक नीित िकस वषर् में अपनायी गई गयी थी?

Options :

1.  1948

2.  1956

3.  1985

4.  1991
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Correct Marks : 1 Wrong Marks : 0

In India, the liberal Industrial Policy was adopted in the year:

Options :

1.  1948

2.  1956

3.  1985

4.  1991
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योग दशर्न का प्रितपादक िनम्न में से िकसे माना जाता है?

Options :

1.  पतंजिल

2.  गौतम

3.  जैिमनी

4.  शंकराचायर्
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Who among the following was the expounder of Yoga Philosophy?

Options :

1.  Patanjali



2.  Gautam

3.  Jaimini

4.  Sankaracharya
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माइकल फरेरा (Michael Ferreira) का संबंध िनम्निलिखत में से िकस खेल से है?

Options :

1.  टेिनस

2.  गोल्फ़

3.  िबिलयड्र्स

4.  शतरंज
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Michael Ferreira is associated with which of the following games/sports?

Options :

1.  Tennis

2.  Golf

3.  Billiards

4.  Chess
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सूची-I (मैदान) को सूची-II (उत्पित्त माध्यम) से सुमेिलत कीिजए। 

 

सूची-I सूची-II

A. िचली घाटी 1. अपरदनीय मैदान

B. गुएना के मैदान 2. िहमनदीय िनक्षेपक मैदान

C. रुसी मैदान 3. िगिरपद मैदान

D. पिश्चमी यूरोप 4. सरंचनात्मक मैदान

Options :

1.  A-3, B-1, C-4, D-2

2.  A-3, B-2, C-1, D-4

3.  A-2, B-3, C-4, D-1

4.  A-4, B-1, C-3, D-2

   

Question Number : 73 Question Id : 25498929938 Question Type : MCQ Option Shuffling : Yes 
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Match the Plains in list I with the Mode of Occurence in list II. 

 

     List I                              List II 

A. Chile valley             1. Erosion plain 

B. Guinea plain           2. Glacial depositional plain 

C. Russian platform    3. Piedmont plain 

D. Western Europe     4. Structural plain

Options :



1.  A-3, B-1, C-4, D-2

2.  A-3, B-2, C-1, D-4

3.  A-2, B-3, C-4, D-1

4.  A-4, B-1, C-3, D-2
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लंदन के रॉयल िफ़लहामोर्िनक ऑकेर् स्ट्रा के िलए धुन बनाने वाले पहले एिशयाई होने का गौरव िनम्निलिखत में से िकस भारतीय संगीत 

िनदेर्शक को प्राप्त हुआ?

Options :

1.  नदीम श्रवण

2.  आनंद िमिलंद

3.  िशव हिर

4.  इलयाराजा
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Which Indian music director had the distinction of being the first Asian to compose a symphony 

for Royal Philharmonic Orchestra of London?

Options :

1.  Nadeem Sharavam

2.  Anand-Milind

3. 



 Shiv Hari

4.  Ilayaraja

   

Question Number : 75 Question Id : 25498932495 Question Type : MCQ Option Shuffling : Yes 
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NABARD (नाबाडर्) की स्थापना िकस दौरान की गई थी?

Options :

1.  चौथी पंचवषीर्य योजना

2.  पांचवीं पंचवषीर्य योजना

3.  छठी पंचवषीर्य योजना

4.  आठवीं पंचवषीर्य योजना
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NABARD was established in the:

Options :

1.  Fourth Five-Year Plan

2.  Fifth Five-Year Plan

3.  Sixth Five-Year Plan

4.  Eighth Five-Year Plan
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Summer camps are supervised camps conducted to entertain as well as equip students with 

various life skills such as teamwork, socializing, decision making, independent and 

responsible living and more. It aids the overall development of a child and children have fun 

during this process as they get to explore new arenas.
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Discipline is one of the most significant personality traits in the life of an individual. Saints 

and monks who meditate also first practice the art of discipline. A person who is well 

disciplined is on track and has orderliness in life. Discipline is the bridge between goals and 

accomplishment. Hence it is the key to success. Discipline establishes a good basis for being 

independent and organized in life. Discipline is a very important pillar in the foundation of 

the life of an individual. It also means following certain acceptable standards of behaviour. 

A life without discipline is a life full of chaos and confusion. Most noteworthy discipline 

makes a person into a better human being. Discipline is a trait of paramount importance. 

Discipline helps an individual in becoming more focused. A person of discipline tends to have 



a much better view of his activities and goals. Discipline makes a person avoid distractions 

of various kinds. A feeling of sincerity and seriousness comes in due to discipline. 

Consequently high quality focus is the result of discipline. Discipline also brings a lot of 

respect for an individual from others. A disciplined individual by his very nature would 

command respect from all people. Bringing discipline in life is a task that requires patience 

and dedication. Another notable impact of discipline is good health. A disciplined individual 

has a proper schedule of doing everything. Therefore a disciplined has a fixed time schedule 

for eating and sleeping and other daily activities. Such an individual is very strict with 

regard to his diet as well. All of these measures ensure good health and body fitness of the 

individual. Self control is a praiseworthy benefit of discipline. A person of discipline exercises 

better restraint and control over his actions. A disciplined person is very careful with the use 

of his words when talking with others. Such an individual ensures that his behaviour is 

decent and appropriate at all times. A disciplined individual will certainly have more time 

than an undisciplined individual. This is because a person of discipline will not waste time in 

useless or worthless activities. Furthermore an individual of discipline will not donate 

excessive time on any one task. By following this approach people would have a lot of free 

time with them. This free time would certainly not have been possible in case of indiscipline. 

Time management is a very popular technique of discipline. Time management utilizes time 

as a regulator and the observer of time as the governor. Time management ensures that the 

usage of time takes place in an efficient manner. Moreover time management marks each 

activity within a boundary of time. Each activity and task must begin and end at a specific 

fixed time. Responsibility based discipline is another technique. This technique equips 

members of an organization to understand remedies for a problem. Responsibility based 

discipline involves laying out instructions for modifying future behaviour. Also this takes 

place by following good respectful role models. In conclusion discipline is a significantly 

important quality to have in every walk of life. Discipline is certainly the ladder towards 

success. Life without discipline is just like a house without a roof. It is absolutely essential 

for successful life. Discipline brings out the best in us. Most noteworthy discipline keeps our 

body and mind in sync.
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एक बार की बात है, अकबर और बीरबल िशकार पर जा रहे थे। अभी कुछ समय की उन्हें एक िहरण िदखा। जल्दबाजी में तीर िनकालते 

हुए अकबर अपने हाथ पर घाव लगा बैठा। अब हालात कुछ ऐसे थे की अकबर बहुत ददर् में था और गुस्से में भी।
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भारत में छह ऋतुए ंपाई जाती हैं िजनके नाम गमीर् व वषार् व शरद व हेमंत तथा िशिशर और वसंत हैं। इनमें वसंत को ऋतुराज और वषार् 

को ऋतओुं की रानी कहा जाता है। यिद मैं सच कहूं तो वषार् ही वह ऋतु है िजसका लोग सवार्िधक आतुरता से इंतजार िकया करते हैं। 

कुछ समय पवूर् तक भारतीय कृिष को मानसून का जुआ कहा जाता था। ऐसा इसिलए कहा जाता था िक भारतीय कृिष पूरी तरह से वषार् 

पर िनभर्र होती थी तथा गमीर् के मारे पशु व पक्षी तथा इंसान सभी बेहाल हो जाते थे। छोटे छोटे वृक्ष व पौधे सूख जाते थे। धरती गमर् तवे 

सी तपने लगती थी। ऐसे में सभी बहुत आतुरता से वषार् का इंतजार करते लगते थे। मुझे याद है िक आषाढ माह के पंद्रह िदन यूं ही तपते 



तपते बीत जाते थे और इस समय गमीर् अपने चरम पर होती थी। ऐसे में सभी को बेसब्री से वषार् का इंतजार रहता था परंतु बादल मानो 

रूठे से रहते थे। बालक तो कई बार टोली बनाकर जमीन पर लेट लेटकर गाने लगते िक काले मेघा पानी दे पानी दे गुडधानी दे। इस तरह 

गा गा कर बालक बादलों को बुलाते थे पर सब बेकार सािबत होता था। िफर एक िदन कुछ यूं हुआ िक दोपहर का समय था व अचानक 

बादलों के कुछ टुकडों ने पहले तो सूरज को ढक िलया और िफर वे बादल पूरे आसमान में छा गए। देखते ही देखते हवा में शीतलता का 

एहसास होने लगा। िदन में ही शाम होने का एहसास होने लगा। अचानक िबजली चमकी और बादलों ने अपने आने की सूचना मानो सभी 

को दे दी और आसमान से शीतल बूंदें िगरने लगीं। िफर धीरे धीरे ये बूंदें घनी और बडी होने लगीं तथा धीरे धीरे बूंदों की एक झडी सी लग 

गई। िफर हवा के एक दो तेज झोंके आए और तेज वषार् शुरू हो गई। वषार् का वेग बढने के साथ साथ हमारे मन की उमंग एवं खुशी भी 

बढती जा रहा थी। िफर हम बालक कहां रुकने वाले थे। हम नहाने के िलए घर से िनकल आए। गमीर् की ऋतु ने हमें िजतना तपाया था 

अब वह सारी तपन हम वषार् में शीतल कर लेना चाहते थे। वषार् भी िकतनी शीतल और सुखद लगती है। यह तो भीगने वालों से ही जाना 

जा सकता है। हम सभी बालक जम कर नहाए और खूब धमाचौकडी भी की। कोई उछल कूद कर रहा था तो कोई बािरश में नाच रहा 

था। कुछ बालक कागज की नाव बना कर पानी में चलाने लगे। दो घंटे की लगातार वषार् में सब कुछ जल मगन हो गया। खेतों व बागों 

तथा गिलयों की नीची जगहें तालाब का रूप धारण कर चुकी थीं। वृक्ष व पौधे िबलकुल नहाए धोए और सुंदर लगने लगे थे। लोगों के 

चेहरों पर छायी मायूसी गायब हो चुकी थी और अब उन चेहरों पर मायूसी की जगह चमक थी। जंगल की ओर से मयूरों की कणर्िप्रय 

आवाज जोर जोर से आने लगी थी। सभी िकसान खेत की ओर चल पडे। ऐसे में हम बालक कहां शांत बैठने वाले थे। हम भी कागज की 

नाव िलए तालाब की ओर चल पडे। हमें भी अभी जल क्रीडा का और आनंद लेना था। तालाब पानी से लबा लब भर गया था। सभी 

बालकों ने तालाब में अपनी अपनी नाव डाली व जोर शोर से उनको चलाने लगे।
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